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Notice

Every effort was made to ensure that the information in this document
was complete and accurate at the time of printing. However, information
is subject to change.

Warranty

Avaya Inc. provides a limited warranty on this product. Refer to your
sales agreement to establish the terms of the limited warranty. In
addition, Avaya'’s standard warranty language as well as information
regarding support for this product, while under warranty, is available
through the following Web site: http://www.avaya.com/support.

Preventing Toll Fraud

"Toll fraud" is the unauthorized use of your telecommunications system
by an unauthorized party (for example, a person who is not a corporate
employee, agent, subcontractor, or is not working on your company's
behalf). Be aware that there may be a risk of toll fraud associated with
your system and that, if toll fraud occurs, it can result in substantial
additional charges for your telecommunications services.

Avaya Fraud Intervention

If you suspect that you are being victimized by toll fraud and you need
technical assistance or support, in the United States and Canada, call the
Technical Service Center's Toll Fraud Intervention Hotline at
1-800-643-2353.

Disclaimer

Avaya is not responsible for any modifications, additions or deletions to
the original published version of this documentation unless such
modifications, additions or deletions were performed by Avaya. Customer
and/or End User agree to indemnify and hold harmless Avaya, Avaya's
agents, servants and employees against all claims, lawsuits, demands
and judgments arising out of, or in connection with, subsequent
modifications, additions or deletions to this documentation to the extent
made by the Customer or End User.

How to Get Help

For additional support telephone numbers, go to the Avaya support Web
site: http://www.avaya.com/support. If you are:

. Within the United States, click the Escalation Management
link. Then click the appropriate link for the type of support you
need.

. Outside the United States, click the Escalation Management
link. Then click the International Services link that includes
telephone numbers for the international Centers of
Excellence.

Providing Telecommunications Security

Telecommunications security (of voice, data, and/or video
communications) is the prevention of any type of intrusion to (that is,
either unauthorized or malicious access to or use of) your company's
telecommunications equipment by some party.

Your company's "telecommunications equipment" includes both this
Avaya product and any other voice/data/video equipment that could be
accessed via this Avaya product (that is, "networked equipment”).

An "outside party" is anyone who is not a corporate employee, agent,
subcontractor, or is not working on your company's behalf. Whereas, a
"malicious party" is anyone (including someone who may be otherwise
authorized) who accesses your telecommunications equipment with
either malicious or mischievous intent.
Such intrusions may be either to/through synchronous (time-multiplexed
and/or circuit-based), or asynchronous (character-, message-, or
packet-based) equipment, or interfaces for reasons of:
. Utilization (of capabilities special to the accessed equipment)
. Theft (such as, of intellectual property, financial assets, or toll
facility access)

. Eavesdropping (privacy invasions to humans)
. Mischief (troubling, but apparently innocuous, tampering)
. Harm (such as harmful tampering, data loss or alteration,

regardless of motive or intent)

Be aware that there may be a risk of unauthorized intrusions associated
with your system and/or its networked equipment. Also realize that, if
such an intrusion should occur, it could result in a variety of losses to your
company (including but not limited to, human/data privacy, intellectual
property, material assets, financial resources, labor costs, and/or legal
costs).

Responsibility for Your Company’s Telecommunications Security

The final responsibility for securing both this system and its networked
equipment rests with you - Avaya’s customer system administrator, your
telecommunications peers, and your managers. Base the fulfillment of
your responsibility on acquired knowledge and resources from a variety
of sources including but not limited to:

. Installation documents

. System administration documents

. Security documents

. Hardware-/software-based security tools

. Shared information between you and your peers
. Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you and
your peers should carefully program and configure:

. Your Avaya-provided telecommunications systems and their
interfaces

. Your Avaya-provided software applications, as well as their
underlying hardware/software platforms and interfaces

. Any other equipment networked to your Avaya products

TCP/IP Facilities

Customers may experience differences in product performance, reliability
and security depending upon network configurations/design and
topologies, even when the product performs as warranted.

Standards Compliance

Avaya Inc. is not responsible for any radio or television interference
caused by unauthorized modifications of this equipment or the
substitution or attachment of connecting cables and equipment other
than those specified by Avaya Inc. The correction of interference caused
by such unauthorized modifications, substitution or attachment will be the
responsibility of the user. Pursuant to Part 15 of the Federal
Communications Commission (FCC) Rules, the user is cautioned that
changes or modifications not expressly approved by Avaya Inc. could
void the user’s authority to operate this equipment.

Product Safety Standards

This product complies with and conforms to the following international
Product Safety standards as applicable:

Safety of Information Technology Equipment, IEC 60950, 3rd Edition, or
IEC 60950-1, 1st Edition, including all relevant national deviations as
listed in Compliance with IEC for Electrical Equipment (IECEE) CB-96A.
Safety of Information Technology Equipment, CAN/CSA-C22.2
No. 60950-00 / UL 60950, 3rd Edition, or CAN/CSA-C22.2 No.
60950-1-03 / UL 60950-1.
Safety Requirements for Information Technology Equipment, AS/NZS
60950:2000.
One or more of the following Mexican national standards, as applicable:
NOM 001 SCFI 1993, NOM SCFI 016 1993, NOM 019 SCFI 1998.
The equipment described in this document may contain Class 1 LASER
Device(s). These devices comply with the following standards:

. EN 60825-1, Edition 1.1, 1998-01

. 21 CFR 1040.10 and CFR 1040.11.
The LASER devices used in Avaya equipment typically operate within the
following parameters:

Typical Center Wavelength Maximum Output Power

830 nm - 860 nm -1.5dBm
1270 nm - 1360 nm -3.0dBm
1540 nm - 1570 nm 5.0dBm

Luokan 1 Laserlaite
Klass 1 Laser Apparat

Use of controls or adjustments or performance of procedures other than
those specified herein may result in hazardous radiation exposures.
Contact your Avaya representative for more laser product information.
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Electromagnetic Compatibility (EMC) Standards

This product complies with and conforms to the following international
EMC standards and all relevant national deviations:
Limits and Methods of Measurement of Radio Interference of Information
Technology Equipment, CISPR 22:1997, EN55022:1998, and AS/NZS
3548.
Information Technology Equipment - Immunity Characteristics - Limits
and Methods of Measurement, CISPR 24:1997 and EN55024:1998,
including:

. Electrostatic Discharge (ESD) IEC 61000-4-2

. Radiated Immunity IEC 61000-4-3

. Electrical Fast Transient IEC 61000-4-4

. Lightning Effects IEC 61000-4-5

. Conducted Immunity IEC 61000-4-6

. Mains Frequency Magnetic Field IEC 61000-4-8

. Voltage Dips and Variations IEC 61000-4-11
Power Line Emissions, IEC 61000-3-2: Electromagnetic compatibility
(EMC) - Part 3-2: Limits - Limits for harmonic current emissions.
Power Line Emissions, IEC 61000-3-3: Electromagnetic compatibility
(EMC) - Part 3-3: Limits - Limitation of voltage changes, voltage
fluctuations and flicker in public low-voltage supply systems.

Federal Communications Commission Statement

Part 15:

Means of Connection

Connection of this equipment to the telephone network is shown in the
following tables.

For MCC1, SCC1, CMC1, G600, and G650 Media Gateways:

Note: This equipment has been tested and found to comply with
the limits for a Class A digital device, pursuant to Part 15 of the
FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment is
operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if
not installed and used in accordance with the instruction
manual, may cause harmful interference to radio
communications. Operation of this equipment in aresidential
area is likely to cause harmful interference in which case the
user will be required to correct the interference at his own
expense.

Part 68: Answer-Supervision Signaling

Allowing this equipment to be operated in a manner that does not provide
proper answer-supervision signaling is in violation of Part 68 rules. This
equipment returns answer-supervision signals to the public switched
network when:

. answered by the called station,

. answered by the attendant, or

. routed to a recorded announcement that can be administered
by the customer premises equipment (CPE) user.

This equipment returns answer-supervision signals on all direct inward
dialed (DID) calls forwarded back to the public switched telephone
network. Permissible exceptions are:

. A call is unanswered.
. A busy tone is received.
. A reorder tone is received.

Avaya attests that this registered equipment is capable of providing users
access to interstate providers of operator services through the use of
access codes. Modification of this equipment by call aggregators to block
access dialing codes is a violation of the Telephone Operator Consumers
Act of 1990.

REN Number

For MCC1, SCC1, CMC1, G600, and G650 Media Gateways:

This equipment complies with Part 68 of the FCC rules. On either the
rear or inside the front cover of this equipment is a label that contains,
among other information, the FCC registration number, and ringer
equivalence number (REN) for this equipment. If requested, this
information must be provided to the telephone company.

For G350 and G700 Media Gateways:

This equipment complies with Part 68 of the FCC rules and the
requirements adopted by the ACTA. On the rear of this equipment is a
label that contains, among other information, a product identifier in the
format US:AAAEQ##TXXXX. The digits represented by ## are the ringer
equivalence number (REN) without a decimal point (for example, 03 is a
REN of 0.3). If requested, this number must be provided to the telephone
company.

For all media gateways:

The REN is used to determine the quantity of devices that may be
connected to the telephone line. Excessive RENs on the telephone line
may result in devices not ringing in response to an incoming call. In most,
but not all areas, the sum of RENs should not exceed 5.0. To be certain
of the number of devices that may be connected to a line, as determined
by the total RENs, contact the local telephone company.

REN is not required for some types of analog or digital facilities.

Manufacturer’s Port FIC Code SOC/ Network
Identifier REN/ Jacks
A.S. Code
Off premises station OoL13C 9.0F RJ2GX,
RJ21X,
RJ11C
DID trunk 02RV2-T 0.0B RJ2GX,
RJ21X
CO trunk 02GS2 0.3A RJ21X
02LS2 0.3A RJ21X
Tie trunk TL31M 9.0F RJ2GX
Basic Rate Interface 02IS5 6.0F, 6.0Y RJ49C
1.544 digital interface 04DU9-BN 6.0F RJ48C,
RJ48M
04DU9-IKN 6.0F RJ48C,
RJ48M
04DU9-ISN 6.0F RJ48C,
RJ48M
120A4 channel service 04DU9-DN 6.0Y RJ48C
unit
For G350 and G700 Media Gateways:
Manufacturer’s Port FIC Code SOC/ Network
Identifier REN/ Jacks
A.S. Code
Ground Start CO trunk 02GS2 1.0A RJ11C
DID trunk 02RV2-T AS.0 RJ11C
Loop Start CO trunk 02LSs2 0.5A RJ11C
1.544 digital interface 04DU9-BN 6.0Y RJ48C
04DU9-DN 6.0Y RJ48C
04DU9-IKN 6.0Y RJ48C
04DU9-ISN 6.0Y RJ48C
Basic Rate Interface 02IS5 6.0F RJ49C

For all media gateways:

If the terminal equipment (for example, the media server or media
gateway) causes harm to the telephone network, the telephone company
will notify you in advance that temporary discontinuance of service may
be required. But if advance notice is not practical, the telephone
company will notify the customer as soon as possible. Also, you will be
advised of your right to file a complaint with the FCC if you believe it is
necessary.

The telephone company may make changes in its facilities, equipment,
operations or procedures that could affect the operation of the
equipment. If this happens, the telephone company will provide advance
notice in order for you to make necessary modifications to maintain
uninterrupted service.

If trouble is experienced with this equipment, for repair or warranty
information, please contact the Technical Service Center at
1-800-242- 2121 or contact your local Avaya representative. If the
equipment is causing harm to the telephone network, the telephone
company may request that you disconnect the equipment until the
problem is resolved.




A plug and jack used to connect this equipment to the premises wiring
and telephone network must comply with the applicable FCC Part 68
rules and requirements adopted by the ACTA. A compliant telephone
cord and modular plug is provided with this product. It is designed to be
connected to a compatible modular jack that is also compliant. It is
recommended that repairs be performed by Avaya certified technicians.
The equipment cannot be used on public coin phone service provided by
the telephone company. Connection to party line service is subject to
state tariffs. Contact the state public utility commission, public service
commission or corporation commission for information.

This equipment, if it uses a telephone receiver, is hearing aid compatible.

Canadian Department of Communications (DOC) Interference
Information

This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conforme a la norme
NMB-003 du Canada.

This equipment meets the applicable Industry Canada Terminal
Equipment Technical Specifications. This is confirmed by the registration
number. The abbreviation, IC, before the registration number signifies
that registration was performed based on a Declaration of Conformity
indicating that Industry Canada technical specifications were met. It does
not imply that Industry Canada approved the equipment.

Installation and Repairs

Before installing this equipment, users should ensure that it is
permissible to be connected to the facilities of the local
telecommunications company. The equipment must also be installed
using an acceptable method of connection. The customer should be
aware that compliance with the above conditions may not prevent
degradation of service in some situations.

Repairs to certified equipment should be coordinated by a representative
designated by the supplier. Any repairs or alterations made by the user to
this equipment, or equipment malfunctions, may give the
telecommunications company cause to request the user to disconnect
the equipment.

Declarations of Conformity
United States FCC Part 68 Supplier’'s Declaration of Conformity (SDoC)

Avaya Inc. in the United States of America hereby certifies that the
equipment described in this document and bearing a TIA TSB-168 label
identification number complies with the FCC’s Rules and Regulations 47
CFR Part 68, and the Administrative Council on Terminal Attachments
(ACTA) adopted technical criteria.

Avaya further asserts that Avaya handset-equipped terminal equipment

described in this document complies with Paragraph 68.316 of the FCC

Rules and Regulations defining Hearing Aid Compatibility and is deemed
compatible with hearing aids.

Copies of SDoCs signed by the Responsible Party in the U. S. can be
obtained by contacting your local sales representative and are available
on the following Web site: http://www.avaya.com/support.

All Avaya media servers and media gateways are compliant with FCC
Part 68, but many have been registered with the FCC before the SDoC
process was available. A list of all Avaya registered products may be
found at: http://www.part68.org by conducting a search using "Avaya" as
manufacturer.

European Union Declarations of Conformity

Cce

Avaya Inc. declares that the equipment specified in this document
bearing the "CE" (Conformité Europeénne) mark conforms to the
European Union Radio and Telecommunications Terminal Equipment
Directive (1999/5/EC), including the Electromagnetic Compatibility
Directive (89/336/EEC) and Low Voltage Directive (73/23/EEC).
Copies of these Declarations of Conformity (DoCs) can be obtained by
contacting your local sales representative and are available on the
following Web site: http://www.avaya.com/support.

Japan

This is a Class A product based on the standard of the Voluntary Control
Council for Interference by Information Technology Equipment (VCCI). If
this equipment is used in a domestic environment, radio disturbance may

occur, in which case, the user may be required to take corrective actions.

ZOEET, FEALEREE S ENEE 8 TN s (VCC 1) okl
TS 2 F A A HHEGNER T, ZORBLFERETHENT % LB
EAEBI RIS IEREY E, ZOBEITIERE S E Y A g
LEIERENSHZILEBHVET,

To order copies of this and other documents:
Call:  Avaya Publications Center

Voice 1.800.457.1235 or 1.207.866.6701

FAX 1.800.457.1764 or 1.207.626.7269
Write: Globalware Solutions

200 Ward Hill Avenue

Haverhill, MA 01835 USA

Attention: Avaya Account Management
E-mail: totalware@gwsmail.com

For the most current versions of documentation, go to the Avaya support
Web site: http://www.avaya.com/support.
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Chapter 1. Introduction

Purpose

The purpose of this book is to provide the following information:

« Hardware and software requirements for Microsoft® Windows® servers and Windows
client PCs.

« Pre-installation tasks that must be completed prior to installation.

« Procedures to install the products in the Avaya Integrated Management, Standard
Management offer. If any of the products included in this offer are already installed on your
system, those products will be upgraded during this installation.

Prerequisites

System administrators who install the Standard Management software should be experienced
in installing software on Windows operating systems.

Intended Audience

This book is written for system administrators who are responsible for installing software on
Windows servers and clients.
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Introduction

Conventions Used in This Book

The following typographical conventions are used:

» Bold type is used to indicate information that you type, buttons in a window, and the Enter
key on the keyboard. It is also used for emphasis.

. Couri er fontis used for any information that the computer screen displays.

« Arrows indicate options that you select from cascading menus; for example, “Select File >
Open” means choose the “Open” option from the “File” menu.

Support Resources

Avaya provides a variety of planning, consulting, and technical services. The following sections
describe the resources and services that are available.

Avaya Technology and Consulting (ATAC)

Avaya Technology and Consulting (ATAC) works with client teams to develop detailed solutions
for connectivity to Avaya Communication Manager solutions. The ATAC also designs network
configurations.

Communications, Solutions, and Integration (CSI)
Group of Software Services
Avaya Communications, Solutions, and Integration (CSI) Group of Software Services offers
customers the following services:
« Platform readiness verification
- Remote implementation and installation
« Network management server configuration
« Customer acceptance verification

« Custom on-site services

8 Avaya Integrated Management Standard Management Installation and Upgrade



Support Resources

The CSI Group consists of the following two teams:
« Converged Solutions Implementation Engineering

The Converged Solutions Implementation Engineering (CSIE) team implements multi-site
media gateway (G350/G650/G700) deployment projects for both voice and data design.
The overall direction of the CSIE team is to bring the correct methodology to these complex
deployments that span various regions and to provide continuity to the overall project from
the voice and data implementation standpoint.

« Data Network Implementation Engineering (formerly RNIS)

The Data Network Implementation Engineering team implements and/or upgrades existing
or new data networks. This team analyzes the customer’s network design requirements and
performance expectations, and then creates the hardware and software installation
specification used to implement data devices including Cajun, VPN, Wireless LAN, Secure
Gateways, Extreme, and multi-vendor data equipment.

The CSI Group provides support on a contract basis. You can purchase various implementation
offers from the CSI Group in Tampa, Florida. See Table 1: Customer-Accessible Resources on
page 11 for contact information.

Avaya Technical Service Organization (TSO)

The Avaya Technical Service Organization (TSO) provides support to the Avaya Integrated
Management client teams, field technicians, and customers. The TSO will bill customers for
support on a time and materials basis if the following conditions exist:

« Customers do not provide remote access.
« Customers do not have a current maintenance agreement.

« Customers do not procure and install the required systems and software as defined in the
Integrated Management Services Support Plan.

« Customers request support that is outside the purchase agreement.

The TSO does not support hardware or software that customers purchase from third-party
vendors.

Avaya Network Management Software Systems Support Group
(NMSSS)

The Avaya Network Management Software Systems Support Group (NMSSS) in Tampa Bay,
Florida answers customer calls about products in Avaya Integrated Management. NMSSS will
either answer your questions directly or connect you with an associate who can answer
guestions about the products.

Issuel June 2005 9



Introduction

Customized Management Solutions for Avaya Integrated
Management

The Integrated Management Product Team understands customer’s needs and is focused on
customer satisfaction. See Table 1: Customer-Accessible Resources on page 11 for contact
information. The Product Team will assist customers with Avaya Integrated Management
projects and will provide:

. Project Management — An Integrated Management project person will work with the
customer to access configuration and customization requirements for any or all
applications within each Avaya Integrated Management offer. If custom work is required,
the evaluation will include a proposed statement of work and price. Note that this offer is
not intended to provide installation for customers that choose to implement Integrated
Management applications using Avaya Services or third-party implementation services.

« Training — Basic training can be performed remotely using an interactive medium to
display the applications and a conference bridge for audio. On-site training can be
customized to meet the customer’s needs. Customized training will focus on application
functionality that is relevant to the customer and provide focused knowledge transfer to
facilitate application-specific training.

10 Avaya Integrated Management Standard Management Installation and Upgrade



Support Resources

Avaya Contact Information

Table 1 and Table 2 provide contact information that you may use if you need assistance during
the process of installing and setting up Avaya Integrated Management. To access the links in
Table 2, you must be able to access the Avaya intranet.

Table 1: Customer-Accessible Resources

Resource

Contact Information

Avaya Support Center

http://www.avaya.com/support

Network Management
Software Systems
Support (NMSSS)

+1 800 237-0016

Communications,
Solutions, and
Integration (CSI)
Group of Software
Services

+1 800 730-9108, prompt 3

Integrated
Management Product
Team

Send email to: AIMtraining@avaya.com

Toll Fraud Intervention

+1 800 643-2353, prompt 1

Table 2: Avaya Internal Resources

Resource

Contact Information

Avaya System
Management Support

http://aem-support.dr.avaya.com

Avaya Technology and
Consulting (ATAC)

+1 888 297-4700, prompt 2,6
http://forum.avaya.com (requires a password)

Communications,
Solutions, and
Integration (CSI)
Group of Software
Services

http://associate2.avaya.com/sales market/products/
data-implementation-services/

Integrated
Management Services
Support Plan

http://associate2.avaya.com/solution/support_plans/#Enterprise

Issue 1l June 2005
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Introduction

Product Documentation

The latest version of Avaya Integrated Management product documentation, including this
book, is available from the Avaya Support Web Site. To view or download these books from the
Web, you must have access to the Internet, an Internet browser, and Adobe Acrobat Reader,
version 5.0 or later. Adobe Acrobat Reader is provided on the Avaya Integrated Management
CDs and is also available from http://www.adobe.com. See How to Access Books on the Web
for instructions on how to view or download these books.

How to Access Books on the Web

To view or download books from the Avaya Support Web Site, follow these steps:

1. Access http://www.avaya.com/support.

2. In the left column, click System and Network Management.

3. Scroll to Integrated Management, locate the product name, and click the link
corresponding to the software release to display a list of available books for that product.

Tell Us What You Think!

Let us know how this book measured up to your expectations. Your opinions are crucial to
helping us meet your needs! Send us your comments by mail, fax, or e-mail as follows:

Mail: Avaya Inc.
Avaya Integrated Management Documentation Team
Room 3C-313
307 Middletown Lincroft Rd.
Lincroft, NJ 07738
USA

Fax: Avaya Integrated Management Documentation Team
+ 1 732 852-2469

E-mail: document@avaya.com
Subject:  Avaya Integrated Management Documentation Team

12 Avaya Integrated Management Standard Management Installation and Upgrade
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Chapter 2. Overview

Standard Management

The Standard Management is a Windows solution for Avaya Integrated Management. It is
designed for small-to-medium size networks that run Windows platforms. With this offer, you
receive the following management tools:

« Avaya Site Administration

Avaya Site Administration enables you to administer and manage Avaya voice systems and
Avaya converged devices.

« Avaya Voice Over IP Monitoring Manager (90-day trial version)

Avaya Voice Over IP (VolP) Monitoring Manager enables you to monitor and review the
quality of a call on an Avaya VoIP network.

The Standard Management offer provides one user license. Customers can purchase two
additional options—one that is for up to five Avaya Communication Managers and provides up
to five user licenses, and another that is for up to ten Avaya Communication Managers and
provides up to ten user licenses. In addition, an add-on option is available that provides
unlimited client licenses for Avaya Site Administration.

Standard Management CDs

Standard Management is provided on the following CDs:

. Avaya Site Administration (See Chapter 3: Avaya Site Administration Installation on
page 15.)

« VoIP Monitoring Manager (90-day trial) (See Chapter 4: VVolP Monitoring Manager
Installation on page 19.)
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Chapter 3: Avaya Site Administration Installation

Overview of Avaya Site Administration

Avaya Site Administration is a Windows application that enables you to

« administer and manage voice systems running Avaya Communication Manager software

. add, change, and remove mailboxes on messaging systems

To simplify your day-to-day administration tasks (such as finding unused stations, changing

users, and adding users), Avaya Site Administration provides several wizards. At any time, you

can use the GEDI in Avaya Site Administration to enter Avaya Communication Manager
commands that you would typically enter from a terminal emulation window or system
administration terminal (SAT).

Avaya Site Administration CD

The Avaya Site Administration CD contains products that you install directly onto a Windows
PC. See PC Requirements on page 16for the minimum PC requirements. Before installing this

CD, also see Pre-Installation Tasks on page 15.

The Standard Management CD contains the following applications:
« Avaya Site Administration

« Adobe Acrobat Reader (required to view documents)

Pre-Installation Tasks

Before installing Avaya Site Administration, you must complete the following pre-installation
tasks.

1. Check the minimum hardware and software requirements. See PC Requirements on
page 16.

2. For upgrade installations, check that all previous sequential upgrades and/or major
releases were installed before installing this release. If the wizard detects a software
upgrade that is not sequential, the wizard will stop and display a message to install the
skipped releases. The wizard will then abort the installation.
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3. Carefully review Avaya Integrated Management Implementation Guidelines, document
number 555-233-163. This document is available from the Avaya Support Web Site. (See
How to Access Books on the Web on page 12.) This document describes server
configuration requirements and provides pre-installation forms that must be completed
before you begin installing the Avaya Integrated Management products. The pre-installation
forms contain information that you will need to install the products, such as IP addresses,
server domain names, and port addresses.

4. Carefully review this entire book before you install the software.

PC Requirements
Table 3 provides the requirements for the PC.

Table 3: Windows Client PC Requirements

Component Required Comments
Operating system Microsoft Windows
2000, Windows XP
Professional, or
Windows 2003
Processor 600 MHz Pentium®
Hard Drive 1GB
Memory 256 MB RAM
Monitor SVGA 1024 X 768
display
Network Connectivity TCP/IP 10/100 Network
Card
Modem 56K Modem May be required to access the
voice system or messaging
system.
CD-ROM Drive Required for installation.
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Installing the Software

The procedure to install or upgrade the contents of the Avaya Site Administration CD is
generally the same.

1.
2.

Close all open windows and applications.

Insert the Avaya Integrated Management 3.0, Avaya Site Administration CD into the
CD-ROM drive.

The Avaya Integrated Management Avaya Site Administration 3.0 window appears. It
provides a main menu.

Note:
Install Acrobat Reader if it is not already installed on the computer.

. Click Install Avaya Site Administration.

The Welcome dialog box appears.

. Click the Next button.

The License Agreement dialog box appears.

. Read the license type agreement. If you accept the license type, click the | accept the

terms of the license agreement option button, and then click the Next button.

Note:
You cannot install Avaya Site Administration unless you accept the license type.

The Choose Destination Location dialog box appears. By default, the applications will be
installed in c:\Program Files\Avaya.

. Perform one of the following steps:

« To install the applications in the default folder, click the Next button.

« To change the folder where the applications will be installed, click the Change button,
specify the folder you want to use, and then click the Next button.

The Select Features dialog box appears. This dialog box displays the applications and
components you can install.

Note:
You must install the Required Components. You cannot deselect it.

. Make sure Site Administration is selected, and then click the Next button.

The Start Copying Files dialog box appears.

. Click the Next button.

The Setup Status message box appears showing the status of the installation. When the
installation is complete, the InstallShield Wizard Complete dialog box appears.
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9. Click the Finish button.
10. Remove the CD from the drive, and then click Exit.

To run Avaya Site Administration, select Start>All Programs>Avaya>Site Administration, or
double-click on the Site Administration icon on your desktop. For information on how to use
Avaya Site Administration, access the online help.

Note:
Regularly check the Avaya Support Web Site for software updates.

Uninstalling the Software

This section describes how to uninstall Avaya Site Administration.
To uninstall Avaya Site Administration:
1. Select Start>Control Panel.
The Control Panel window appears.
2. Click on Add or Remove Programs.
The Add or Remove Programs window appears.
3. Click on Avaya Integrated Management Client Standard 3.0.
4. Click the Remove button.
The Welcome dialog box appears.
5. Click the Remove option button.
6. Click the Next button.
A dialog box appears prompting you to confirm that you want to remove the application.
7. Click the Yes button.

The Setup Status message box appears. After the application is removed, the Maintenance
Complete message box appears.

8. Click the Finish button.
9. Close the Add or Remove Programs window.

10. Close the Control Panel window.
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Chapter 4. VolIP Monitoring Manager Installation

Overview of Avaya VolP Monitoring Manager

Avaya Voice Over IP (VolP) Monitoring Manager is a VolP Quality of Service (QoS) monitoring
tool. It enables you to monitor and review the quality of a call on an Avaya VolP Network.

Avaya VolP Monitoring Manager allows you to view QoS data experienced at the endpoints and
during a session. This data displays in real-time or for previously active endpoints. With this
information, you can begin to troubleshoot and isolate problems.

Avaya VoIP Monitoring Manager allows you to:

« Search Endpoints. You can search endpoints active from a specified time in the past or
between a date range. Advanced search options enable you to narrow your search to
match phone numbers, network addresses, or QoS levels.

« View Reports. Once you have a list of endpoints, you can select one or more endpoints in
a session and view the associated reports. The reports display QoS data such as jitter,
round trip time (RTT), and packet loss. This is particularly useful for monitoring gateways
or locating problems at a particular endpoint.

Since you can view reports for endpoints involved in a session, this will assist you with
determining problems that occur between two endpoints or in an isolated area of the
network.

o Export Reports. You can export the report data to a comma separated value (csv) file.
You can open this file in most database and spreadsheet programs such as Microsoft
Excel. Exporting the data to a spreadsheet enables you to manipulate the data so you can
create your own reports.

. Generate Automatic Alarms. You can generate Simple Network Management Protocol
(SNMP) Traps/Alarms, which allow the VolP Monitoring Manager to alert you when the
jitter, RTT or packet loss reaches certain levels. You can routinely monitor the network and
troubleshoot problems.

Avaya VolP Monitoring Manager Components

The Avaya VoIP Monitoring Manager incorporates the Avaya VolP Monitoring Manager
Real-time Transport Control Protocol (RTCP) Monitor and the Avaya VolP Monitoring Manager
Server, which accepts connections from the Avaya VolP Monitoring Manager Client. The server
software must be installed on the network to work correctly. A Windows SNMP Agent must also
be installed on the server.
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VoIP Monitoring Manager also uses a database. During installation, the VolP Monitoring
Manager Integrated MSDE Database is installed by default. However, you can choose to install
a different Microsoft SQL database.

The components and their relationship are described in more detail in the following sections.

Avaya VolP Monitoring Manager Server

The Avaya VoIP Monitoring Manager Server acts as a proxy between the MSDE database and
the Avaya VolIP Monitoring Manager Client. It manages connectivity to the database and
provides an interface to configure the Avaya VolP Monitoring Manager RTCP Monitor. The
server resides on the same PC as the RTCP Monitor. The database can reside on the same PC
as the server and RTCP Monitor, or it can reside on a separate machine.

Avaya VolP Monitoring Manager RTCP Monitor

The Avaya VoIP Monitoring Manager RTCP Monitor collects the RTCP packets sent from the
Avaya endpoints and stores the information in a proprietary database. The RTCP Monitor also
runs as a sub-agent of the Windows SNMP Agent. All the information contained in the database
can be queried using Microsoft SQL.

Avaya VolP Monitoring Manager Client

The Avaya VolP Monitoring Manager Client provides the graphical user interface (GUI). The
client does not communicate with the RTCP Monitor, does not use the Windows SNMP service,
and does not communicate with the database. The data that is displayed is gathered from the
server. The client may be installed on the same machine as the server, or it may be installed on
another machine on the network.

Avaya VoIP Monitoring Manager Web Client

The Avaya VolP Monitoring Manager Client can run as a Web application in a browser. This is
useful if you only have the server installed. To run the Avaya VolP Monitoring Manager Client
as a Web application, the following requirements must be met:

« The server must be running a Web server. The Apache Web server is automatically
installed on the server when the Avaya VolP Monitoring Manager Server software is
installed.
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« The Web server must be configured to publish the file to the following VolP Monitoring
Manager installation path:
C:\Program Files\Avaya\VolP Monitoring Manager\jars\ClientApplet.htm
Note:
The server installation will apply this configuration.

If you run the Web client, you will not have access to some of the features—such as connecting
to a new server — that are available in the application.

WebLM License Server

The WebLM License Server manages your licenses for Avaya Integrated Management
products. It is required when you purchase the VolP Monitoring Manager license key to activate
VoIP Monitoring Manager beyond the 90-trial period. The WebLM License Server is not
required to use the 90-day trial version.

The WebLM License Server application is provided on the VolP Monitoring Manager CD. If you
have purchased the VolP Monitoring Manager license key, install the WebLM License Server. If
the WebLM License Server is already installed on another server, you do not have to install it.
During the installation, you will be prompted for the IP address of the server where the WebLM
application is installed.

See Avaya VoIP Monitoring Manager License Key on page 30 for more information about VolP
Monitoring Manager licenses. See Installing VolP Monitoring Manager Licenses on page 50 for
instructions on how to install VolP Monitoring Manager licenses.

Pre-Installation Tasks

Before installing Avaya VolP Monitoring Manager, you must complete the following
pre-installation tasks.

1. Check the minimum hardware and software requirements for the following:

« Windows server (See VolP Monitoring Manager Server Requirements on page 23.)

« Windows client PC (See VolP Monitoring Manager Client Requirements on page 25.)

Note:

The client and server software communicate using Java Remote Method
Invocation (RMI), and use port 1099 on the machine on which the server is
running. If this port is unavailable, the server will attempt to use the following
ports: 49177, 51173, or 63006. Although it is unlikely that all of these ports will be
in use on a single machine, ensure that at least one of these ports is available.
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10.

. If you are upgrading from the previous release, check that all previous sequential upgrades

and/or major releases of Avaya VolP Monitoring Manager were installed before installing
this release. If the wizard detects a software upgrade that is not sequential, the wizard will
stop and display a message to install the skipped releases. The wizard will then abort the
installation.

Note:

If you are upgrading Avaya VolP Monitoring Manager and there are previous
releases of other Integrated Management applications on the Windows server,
you must either upgrade the other Integrated Management applications to this
version of VolP Monitoring Manager, or install the new version of VolP Monitoring
Manager on another Windows server.

. If you have a large system (greater than 1000 simultaneous IP calls) or plan to keep historic

VoIP Monitoring Manager data for long periods of time, it is recommended that you install
VoIP Monitoring Manager on a separate server than that on which Network Management
Console with System View is installed.

. Ensure that the Windows Simple Network Management Protocol (SNMP) Agent is installed

on the Windows server and set to start automatically. (See Ensuring Windows SNMP
Service is Installed on page 26.)

. Check for valid Community IDs. (See Checking for Valid Community ID on page 27.)

. Configure two Avaya Communication Manager administration forms—the IP Network

Region formand the System Parameters IP-Options form. (See Configuring the Avaya
Communication Manager Administration Forms on page 27.)

. Identify the RTCP Listen Port for the Avaya Communication Manager. The default is 5005.

. Carefully review Avaya Integrated Management Implementation Guidelines, document

number 555-233-163. This document is available from the Avaya Support Web Site. (See
How to Access Books on the Web on page 12.) This document describes server
configuration requirements and provides pre-installation forms that must be completed
before you begin installing the Avaya Integrated Management products. The pre-installation
forms contain information that you will need to install the products, such as IP addresses,
server domain names, and port addresses.

. Complete the Ready Reckoner form. This form is available in the Avaya Integrated

Management Implementation Guidelines, document number 555-233-163. Completing this
form will help you predict the size of your database and therefore help you determine if the
MSDE database will meet your needs. If not, a larger database such as Microsoft SQL can
be installed. You can also use the Ready Reckoner form to adjust numbers, such as RTCP
Reporting Intervals and History Days to determine how to set them to achieve the desired
goal. Changing some numbers can help you obtain better data.

Carefully review this entire book before you start the installation.
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VoIP Monitoring Manager System Requirements

Table 4 and Table 5 provide the minimum system requirements to install and operate the VolP
Monitoring Manager Server and Client software.

Table 4: VoIP Monitoring Manager Server Requirements

Component

Required

Comments

Operating System

Microsoft Windows 2003
Standard Edition server,
Microsoft Windows 2003
Enterprise Edition server,
Microsoft Windows 2000
server, or Microsoft
Windows XP Professional

Only English operating systems
are supported.

Processor 2.8 GHz Pentium® 4 A maximum of two processors
is supported.

Hard Drive 40 GB

Memory 1.5 GB RAM

Network Connectivity

TCP/IP 100 Mbit Network
Card

Only one network interface is
supported. Dual network
interface cards (NICs) or
additional software network
interfaces, such as a VPN
interface, are not supported.

Modem 56K modem for remote
access
CD-ROM Drive Required for installation.
Monitor SVGA 1024 X 768 display
SNMP Agent The Simple Network

Management Protocol
(SNMP) Agent is the
Windows Service that runs
on your computer. Itis
provided with the Windows
operating system CD but is
not installed by default.
When installing the VolP
Monitoring Manager, you
will be prompted to install it,
if it is not already installed.

1of2
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Table 4: VoIP Monitoring Manager Server Requirements (continued)

Component

Required

Comments

Extra Software

Anti-virus software
pcAnywhere

Required for Avaya support.
pcAnywhere is required for
remote access by Avaya
Services.

Web Browser

Internet Explorer 6.0

Required for access to the
Integrated Management
Launch Page and web-based
clients.

Integration with HP
OpenView Network Node
Manager

HP OpenView 7.0.1 or
HP OpenView 7.5.

HP OpenView 7.5 requires a
patch.

HP OpenView is not included
on any Avaya Integrated
Management CD. Customers
must purchase, install, and
maintain HP OpenView. While
Avaya services support
Integrated Management when
installed over HP OpenView,
they do not support the HP
OpenView product itself.

Port

The client and server
software communicate
using Java Remote Method
Invocation (RMI), and use
port 1099 on the machine
on which the server is
running.

If this port is unavailable, the
server will attempt to use
the following ports: 49177,
51173, or 63006. Although it
is unlikely that all of these
ports will be in use on a
single machine, ensure that
at least one of these ports is
available.

20f2
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Table 5: VoIP Monitoring Manager Client Requirements

Component

Required

Comments

Operating System

Microsoft Windows 2000, Windows
XP Professional, or Windows 2003.

Only English operating
systems are supported.

Processor 600 MHz Pentium®

Hard Drive 1GB

Memory 256 MB RAM

Monitor SVGA 1024 X 768 display

Network Connectivity

TCP/IP 10/100 Network Card

Modem 56K Modem May be required for remote
access to the client PC.
CD-ROM Drive Required for installation.

Web Browser

Internet Explorer 6.0

Required to access the
Integrated Management
Launch Page and
web-based client.
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Ensuring Windows SNMP Service is Installed

The Windows SNMP Service must be installed on the VolP Monitoring Manager Server. The
Windows SNMP Service enables the RTCP Monitor to publish the data and is required for the
VolIP Monitoring Manager Server software to function.

The Windows SNMP Service is provided on the Microsoft Windows operating system CD. It is
not automatically installed when the Windows operating system is installed. Before installing the
VoIP Monitoring Manager software, you must confirm that the Windows SNMP Service is
installed on the VolP Monitoring Manager server and set to start automatically. To do this, follow
these steps:

1. Click Start > Settings > Control Panel.

2. Select Administrative Tools.

3. Select Services from the list in the Name column.
4

. Scroll down to see if SNMP Service is installed. It should appear in the Name column and
be set to start automatically.

5. If SNMP Service is not set to run automatically or does not appear, do one of the following:
« If the SNMP service is installed but not set to run automatically, do the following:
1. Right-click on SNMP and select Properties from the context menu.
The SNMP Service Properties dialog box opens.
2. Select Automatic from the Startup Type drop down list and click OK.

« If the Windows SNMP Service is not installed, you must install it from the Windows
operating system CD.

Note:

When you install the SNMP Service from the Windows operating system CD, you
must configure a community name with write-access. VolP Monitoring Manager
will attempt to initially connect using the community name, private. For security
reasons, it is recommended that a different community name be chosen. (See
Checking for Valid Community ID on page 27.)
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Checking for Valid Community ID

The Community ID assigned for your Windows SNMP Servicemust match the Community ID
defined in the Server Options dialog box. By default, the Community ID with read-write
privileges is private, but this may have been changed. Read-write privileges are required for
loading, changing, and saving configuration options.

To check for a valid Community 1D, follow these steps:
1. Click Start > Settings > Control Panel.
2. Select Administrative Tools.
3. Select Services from the list in the Name column.
4. Scroll down to SNMP Service.
5. Right-click on SNMP Service and select Properties from the context menu.
6. Click the Security tab.

The Accepted community names list box displays the Windows SNMP Service community
names.
Note:

The Community ID in the Server Options dialog box must match the ID in the
Windows SNMP Service list of Accepted community names.

Configuring the Avaya Communication Manager
Administration Forms

There are two Avaya Communication Manager administration forms—the System Parameters
IP-Options form and the IP Network Region form—that you administer so that the server
running Avaya Communication Manager sends RTCP reports to the RTCP Monitor. When you
administer the System Parameters IP-Options form, the IP Network Region forms are set, by
default, with the same values. You can then, optionally, make changes to a network region by
changing the region’s IP Network Region form.

Use the following SAT commands to make changes to the values on the forms:
. change ip-network-region <x> where x is a number from 1 to 250.

« change system-parameter ip-options
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Configuring the IP Network Region Form

Figure 1 shows an IP Network Region form. To configure this form, follow these steps:
1. Setthe RTCP Reporting Enabl ed? field toy (yes).

2. Setthe Use Default Server Paraneters? fieldtoy (yes). This indicates that this
network region uses the default values specified on the System Parameters
IP-Optionsform.

Figure 1: IP Network Region Form

1]2)3|a|s5|6|7]|8|9]10]11]12]13]14]15]18]|17]18]19]

Region: 1
Location: [ | Authoritative Domain: |
Hame : |
Intra-region IP-IP Direct Audio: |yes
MEDIA PARAMETERS Inter-region IP-IP Direct Audio: |yes
Codec Set: [1 IP Audio Hairpinning? [y
UDP Port Hin: [2948
UDP Port HMax: [3828 RTCP Reporting Enahled?[ﬂ
DIFFSERU/TOS PARAMETERS RTCP MONITOR SERUER PARAHMETERS
Call Control PHE Ualue: Use Default Server Parameters? @

Audio PHB Value:
Uideo PHE Value:
882.1F/0 PARAMETERS
Call Control 882.1p Priority: [g]
Audio 882.1p Priority: [] AUDIO RESOURCE RESERVATION PARAMETERS
H.323 IP EHDPODINTS RSUP Enabled? [
H.322 Link Bounce Recovery?
Idle Traffic Interval {sec):
Keep-fAlive Interval (sec):
Keep-flive Count:

EIEHE'

In some cases, you may not want to set the Default Parameters to yes. Set the field to n (no)
and specify the IP address of the Windows PC running the server for that network region.

An example of when you might not want to set the Default Parameters to yes is if you have
multiple servers installed on a large system in order to reduce the network traffic between a set
of endpoints and the RTCP Monitor (e.g. low bandwidth link between endpoints in one network
region and a remote RTCP Monitor). The network traffic resulting from RTCP reports being sent
from the endpoints to the RTCP Monitor is usually low, less than 40 bytes per second per
currently active VoIP call (RTP session). Therefore, it is usually unnecessary to have multiple
RTCP Monitors.
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If multiple Servers are installed on the system then the endpoints in each network region can be
configured to send their RTCP reports to different RTCP Monitors.

Configuring the System Parameters IP-Options Form

Figure 2 shows a Systems Parameters IP-Options form. To configure this form, locate the
heading RTCP MONI TOR SERVER and follow these steps:

1. Setthe Def aul t Server | P Address to the address of the Windows PC running the
VoIP Monitoring Manager Server.

2. Setthe Default RTCP Report Period (secs) to 10. This will reduce the amount of
data that needs to be stored and thereby help ensure the MSDE or MSSQL database does
not reach its limit too quickly.

Figure 2: System Parameters IP-Options Form

1]z2]
IP-0OPTIONS 3YSTEM FARAMETERS

IPF MEDIA PACKET PERFORMAHMCE THRESHOLDS

Roundtrip Propagation Delay (ms) High: [Tt | Low: [400
Packet Loss (%) High: (4@ Low: (5

Ping Test Interval (sec): |28
Humber of Pings Per Measurement Interval: (18

RTCP MOHMITOR SERUVER

Default Server IP Address: [ [ [ [ ]

Default 3erver Port: 5865
Default RTCP Report Period({secs): [5 |

AUTOMATIC TRACE ROUTE OH
Link Failure? [y

H.248 HMEDIA GATEWAY H.323 IP EHDPOIHT
Link Loss Delay Timer (min): Link Loss Delay Timer (min): [5 |
Primary Search Time {sec): [7G
Periodic Registration Timer (min): [29]
4 >
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VoIP Monitoring Manager CD

The VolP Monitoring Manager CD contains the following applications:
« VoIP Monitoring Manager Client (90-day trial version)
« VoIP Monitoring Manager Server (90-day trial version)

« WebLM License Server (optional component required when multiple VolP Monitoring
Manager servers are installed)

« Adobe Acrobat Reader (required to view documents)

Note:

The VolP Monitoring Manager Server software must be installed on a machine
connected to the network. The VolP Monitoring Manager Client software may be
installed on the same machine as the server, or it may be installed on another
machine on the network.

Avaya VolP Monitoring Manager License Key

The Monitoring Management offer provides a 90-day trial version of VolP Monitoring Manager.
Customers have the option of purchasing the VolP Monitoring Manager license key. This key is
required to fully activate the VolP Monitoring Manager beyond the 90-day trial period. The
license key is available as an add-on option in the Avaya Integrated Management offers. When
a license key is purchased, an instance of WebLM License Server is required to manage the
license key. See WebLM License Server on page 21 for more information about the WebLM
License Server. See Installing VolP Monitoring Manager Licenses on page 50 for instructions
on how to install VolP Monitoring Manager licenses.

Microsoft SQL 2000 Database

During VoIP Monitoring Manager installation, you can install your own database if you do not
want to install the MSDE database provided on the VolP Monitoring Manager CD. If you are
installing Microsoft SQL 2000 database, it is recommended that you install it on the same server
as VoIP Monitoring Manager to ensure optimal performance.

If VoIP Monitoring Manager with the MSDE database is already installed on the server, and you
plan to install the Microsoft SQL 2000 database on the same server, you must uninstall the
MSDE database.
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To uninstall MSDE, follow these steps:
1. Click Start > Settings > Control Panel.
2. Select Add or Remove Programs.
3. Click Microsoft SQL Server Desktop Engine.

4. Click the Remove button.

Installing the Software

Use this procedure to install VolP Monitoring Manager Server, VolP Monitoring Manager Client,
and WebLM Server on the Windows server. The procedure to install or upgrade Avaya VolP
Monitoring Manager is generally the same.

Note:

If you are upgrading Avaya VolP Monitoring Manager and there are previous
releases of other Integrated Management applications on the Windows server,
you must either upgrade the other Integrated Management applications to this
version of Avaya VoIP Monitoring Manager, or install the new version of Avaya
VolIP Monitoring Manager on another Windows server.

1. Ask all users to log off the system.
2. Close all open windows and applications.

3. Insert the Avaya Integrated Management, VolP Monitoring Manager 3.0 CD into the
CD-ROM drive.

The Avaya Integrated Management VolP Monitoring Manager window appears. It provides
the main menu.

Note:
Install Acrobat Reader if it is not already installed on the computer.
4. Click Install Monitoring Server.
The Welcome dialog box appears.
5. Click the Next button.
The Information dialog box appears.
6. Click the Next button.

The License dialog box appears.
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7. Read the license agreement. If you accept the license agreement, click the | accept the
terms of the license agreement option button, and then click the Next button.

Note:

You cannot install VolP Monitoring Manager unless you accept the license
agreement.

The Choose Destination Location dialog box appears. By default, the application will be
installed in c:\Program Files\Avaya.

8. Perform one of the following steps:
« To install the applications in the default folder, click the Next button.

« To change the folder where the applications will be installed, click the Change button,
specify the folder you want to use, and then click the Next button.

The Select Features dialog box appears. This dialog box displays the applications you can
install. See WebLM License Server on page 21 for information about the WebLM
application.

9. Make sure the applications you want to install are selected, and click the Next button.
The Enter Avaya Integrated Management Server IP Address dialog box appears.

10. Enter the IP Address of your Avaya Integrated Management Launch Page Server, and then
click the Next button. One of the following appears:

« If IS (Microsoft's Web Server) is detected on the server, the Setup Type dialog box
appears. IS will cause a conflict with the Apache HTTP Server. You can change the port
IIS runs on or turn IIS off. To do this, perform one of the following steps:

- To change the port that IS runs on, select Change the port that IIS runs on, and
click the Next button.

The IIS Port Change dialog box appears.

- Enter a new port for 1IS to run on, and click the Next button.

The Enter VolP Monitoring Manager Server Port dialog box appears. Go to Step 11.

- Toturn IS off, select Set IIS WWW Publishing Service to Manual, and click the
Next button.

The Enter VolP Monitoring Manager Server Port dialog box appears. Go to Step 11.

« If IS (Microsoft's Web Server) is not detected on this server, the Enter VolP Monitoring
Manager Server Port dialog box appears. Go to Step 11.
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11. Enter the number of the RTCP Listen Port, and then click the Next button.

Note:
The RTCP Listen Port must be the same as that administered on the Avaya
Communication Manager Server. The default is 5005. See Configuring the Avaya
Communication Manager Administration Forms on page 27.

The Install New Database or Use an Existing Database dialog box appears.

12. Based on whether you are installing VolP Monitoring Manager on a Windows 2000,
Windows 2003, or Windows XP Professional server; or installing VolP Monitoring Manager
and using a database already installed, go to one of the following sections:

« If you want to install the MSDE database that is included on the VoIP Monitoring
Manager CD and you have a Windows 2000 server, go to Installing VolP Monitoring
Manager and MSDE on a Windows 2000 Server on page 33.

. If you want to install the MSDE database that is included on the VolP Monitoring
Manager CD and you have a Windows 2003 or Windows XP Professional server, go to
Installing VolP Monitoring Manager and MSDE on a Windows 2003 or Windows XP
Professional Server on page 37.

. If you want to use a database that is already installed, go to Installing VolP Monitoring
Manager With a Database Already Installed on page 40. This procedure is the same for
Windows 2000, Windows 2003, or Windows XP Professional servers.

Installing VoIP Monitoring Manager and MSDE on a Windows 2000
Server
Use this procedure if you want to install the MSDE database that is provided on the VoIP

Monitoring Manager CD and you have a Windows 2000 server. This procedure also includes
installation of the WebLM server application.

1. See Installing the Software on page 31 and perform Steps 1 through 11. At Step 11, the
following dialog box appears:

The Install New Database or Use an Existing Database dialog box appears.
2. Select Install MSDE from this CD.

A message appears stating MSDE will automatically be installed after VolP Monitoring
Manager is installed and the computer reboots.

3. Click the OK button.

The Database Login Information dialog box appears. The MSDE Administrative login is
provided.
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4. Enter the MSDE Administrator password, confirm the password, and then click the Next
button.

Note:
After you set the MSDE Administrator password, make a note of it in a secure
location. Do not change the MSDE Administrator login provided.

« Ifyou are installing the WebLM License Server, the Enter WebLM Port Information dialog
box appears. Go to Step 5.

« If you are not installing the WebLM License Server, the Enter WebLM Server Information
dialog box appears. Perform one of the following steps:

- If you have licenses to activate VolP Monitoring Manager beyond the 90-day trial
period, enter the IP address of the server on which the WebLM License Server
application is installed, and then click the Next button.

The Enter WebLM Port Information dialog box appears. Go to Step 5.

- If you do not have licenses for VolP Monitoring Manager, leave the IP address field
blank, and then click the Next button.

A message appears stating you have not entered a WebLM IP address and VolP
Monitoring Manager will run as an evaluation version for 90 days. Click the OK button.

The Setup Summary dialog box appears. Go to Step 6.

5. Enter the port number on which the WebLM License Server should run, and then click the
Next button. The default port is 3999.

The Setup Summary dialog box appears.

6. Review the setup information, and then click the Next button.
The Apache HTTP Server Welcome dialog box appears.

7. Click the Next button.
The Apache License Agreement dialog box appears.

8. Read the license agreement. If you accept the license agreement, click the | accept the
terms of the license agreement option button, and then click the Next button.

Note:
You cannot install Apache software unless you accept the license agreement.

The Apache information dialog box appears.
9. Read about the Apache HTTP server, and then click the Next button.

The Server Information dialog box appears.
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14.

15.

16.
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Enter the Network Domain, Server Name, and Administrator’s e-mail address. By default,
Apache HTTP server programs and short cuts will be installed for all users. Choose to
install only for current user if desired.

Note:

Network Domain, Server Name, and Administrator’s e-mail fields must be
completed. The Administrator’s e-mail address allows the system to notify the
administrator if problems occur during the Apache installation.

Click the Next button.
The Setup Type dialog box appears.
Confirm that Typical is selected, and then click the Next button.

The Choose Destination Location dialog box appears. By default, the files will be installed in
c:\Program Files\Apache Group.

Perform one of the following steps:
« To install the files in the default folder, click the Next button.

« To change the folder where the files will be installed, click the Change button, specify the
folder you want to use, and then click the Next button.

The Ready to Install Program dialog box appears.
Click the Install button.

The installation status bar for the Apache HTTP server appears. When the installation is
complete, the Installation Wizard Completed dialog box appears.

Click the Finish button.

The installation status bar for JRE appears. When the installation is complete, one of the
following dialog boxes appeatrs:

. If you are installing the WebLM License Server, the Java 2 License Agreement dialog
box appears. Go to Step 16.

« If you are not installing the WebLM License Server, the Installation Wizard Completed
dialog box appears. Go to Step 20.

Read the license agreement. If you accept the license agreement, click the | accept the
terms of the license agreement option button, and then click the Next button.

Note:
You cannot install Java 2 software unless you accept the license agreement.

The Custom Setup window appears. By default Development Tools is selected.
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17.

18.

19.

20.

21.

22.

23.

24,

25.

26.

27.

Perform one of the following steps:
« To install the files in the default folder, click the Next button.

« To change the folder where the files will be installed, click the Change button, specify the
folder you want to use, and then click the Next button.

The Browser Registration dialog box appears.
Click the Install button.

The installation status bar for Java appears. When the installation is complete, the
InstallShield Wizard Completed dialog box appears.

Click the Finish button.
A message appears stating Java Development Kit will be used to install Apache Tomcat.
Click the OK button.

The installation status bar for VolP Monitoring Manager appears. When the installation is
complete, a message appears stating MSDE will automatically be installed after you reboot
the computer.

Click the OK button.
The InstallShield Wizard Completed dialog box appears.

Remove the CD from the CD-ROM drive, and then click the Finish button to restart the
server.

After the server has restarted, the InstallShield Wizard for MSDE appears.
Click the Next button.

A message appears stating the MSDE database will be installed on Windows with Mixed
Mode Security.

Click the OK button.

The Ready to Install the Program dialog box appears.

Click the Install button.

The MSDE Service Pack Installation Steps dialog box appears.
Download the latest service pack for MSDE as instructed.

Note:
It is recommended that you complete the VolP Monitoring Manager installation,
and then download and install the MSDE service pack.

Click the Next button.

A message appears stating that this download is for new installations only. If you already
have an earlier version of MSDE and would like to upgrade to MSDE 2000 Service Pack 3a
(SP3a), you will need to use the SQL Server 2000 SP3a download.
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28. Click the OK button.

The installation status bar appears. When the installation is complete, the InstallShield
Wizard Complete dialog box appears.

29. Click the Finish button to restart the server.

You can access VolP Monitoring Manager by selecting Start > Programs > Avaya > VoIP
Monitoring Manager. For more information about VolP Monitoring Manager, access the online
help after you start the application.

Initial configuration tasks must be performed the first time you use VolP Monitoring Managetr.
See Avaya VoIP Monitoring Manager Release 3.0 Configuration, document number
555-233-510, for procedures you must perform the first time you run the software.

Installing VolP Monitoring Manager and MSDE on a Windows 2003
or Windows XP Professional Server

Use this procedure if you want to install the MSDE database that is provided on the VolP
Monitoring Manager CD and you have a Windows 2003 or Windows XP Professional server.
This procedure also includes installation of the WebLM server application.

1. See Installing the Software on page 31 and perform Steps 1 through 11. At Step 11, the
following dialog box appears:

The Install New Database or Use an Existing Database dialog box appears.
2. Select Install MSDE from this CD.

A message appears stating the MSDE database will be installed on Windows with Mixed
Mode Security.

3. Click the OK button.

The Database Login Information dialog box appears. The MSDE Administrative login is
provided.

4. Enter the MSDE Administrator password, confirm the password, and then click the Next
button.

Note:

After you set the MSDE Administrator password, make a note of it in a secure
location. Do not change the MSDE Administrator login provided.

« Ifyou are installing the WebLM License Server, the Enter WebLM Port Information dialog
box appears. Go to Step 5.
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10.

11.

12.

« If you are not installing the WebLM License Server, the Enter WebLM Server Information
dialog box appears. Perform one of the following steps:

- If you have licenses to activate VolP Monitoring Manager beyond the 90-day trial
period, enter the IP address of the server on which the WebLM License Server
application is installed, and then click the Next button.

The Enter WebLM Port Information dialog box appears. Go to Step 5.

- If you do not have licenses for VolP Monitoring Manager, leave the IP address field
blank, and then click the Next button.

A message appears stating you have not entered a WebLM IP address and VolP
Monitoring Manager will run as an evaluation version for 90 days. Click the OK button.

The Setup Summary dialog box appears. Go to Step 6.

. Enter the port number on which the WebLM License Server should run, and then click the

Next button. The default port is 3999.

The Setup Summary dialog box appears.

. Review the setup information, and then click the Next button.

The MSDE Service Pack Installation Steps dialog box appears.

. Download the latest service pack for MSDE as instructed.

Note:

It is recommended that you complete the VolP Monitoring Manager installation,
and then download and install the MSDE service pack.

. Click the Next button.

A message appears stating that this download is for new installations only. If you already
have an earlier version of MSDE and would like to upgrade to MSDE 2000 Service Pack 3a
(SP3a), you will need to use the SQL Server 2000 SP3a download.

. Click the OK button.

The Apache HTTP Server Welcome dialog box appears.
Click the Next button.
The Apache License Agreement dialog box appears.

Read the license agreement. If you accept the license agreement, click the | accept the
terms of the license agreement option button, and then click the Next button.

Note:
You cannot install Apache software unless you accept the license agreement.

The Apache information dialog box appears.
Read about the Apache HTTP server, and then click the Next button.

The Server Information dialog box appears.
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14.

15.

16.

17.

18.

19.
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Enter the Network Domain, Server Name, and Administrator’s e-mail address. By default,
Apache HTTP server programs and short cuts will be installed for all users. Choose to
install only for current user if desired.

Note:

Network Domain, Server Name, and Administrator’s e-mail fields must be
completed. The Administrator’s e-mail address allows the system to notify the
administrator if problems occur during the Apache installation.

Click the Next button.
The Setup Type dialog box appears.
Confirm that Typical is selected, and then click the Next button.

The Choose Destination Location dialog box appears. By default, the files will be installed in
c:\Program Files\Apache Group.

Perform one of the following steps:
« To install the files in the default folder, click the Next button.

« To change the folder where the files will be installed, click the Change button, specify the
folder you want to use, and then click the Next button.

The Ready to Install Program dialog box appears.
Click the Install button.

The installation status bar for the Apache HTTP server appears. When the installation is
complete, the Installation Wizard Completed dialog box appears.

Click the Finish button.

The installation status bar for JRE appears. When the installation is complete, one of the
following dialog boxes appeatrs:

. If you are installing the WebLM License Server, the Java 2 License Agreement dialog
box appears. Go to Step 19.

« If you are not installing the WebLM License Server, the Installation Wizard Completed
dialog box appears. Go to Step 23.

Read the license agreement. If you accept the license agreement, click the | accept the
terms of the license agreement option button, and then click the Next button.

Note:
You cannot install Java 2 software unless you accept the license agreement.

The Custom Setup window appears. By default Development Tools is selected.
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20. Perform one of the following steps:
« To install the files in the default folder, click the Next button.

« To change the folder where the files will be installed, click the Change button, specify the
folder you want to use, and then click the Next button.

The Browser Registration dialog box appears.
21. Click the Install button.

The installation status bar for Java appears. When the installation is complete, the
InstallShield Wizard Completed dialog box appears.

22. Click the Finish button.
A message appears stating Java Development Kit will be used to install Apache Tomcat.
23. Click the OK button.

The installation status bar for MSDE appears. When the installation is complete, the
InstallShield Wizard Completed dialog box appears.

24. Click the OK button.

The installation status bar for VolP Monitoring Manager appears. When the installation is
complete, the InstallShield Wizard Completed dialog box appears.

25. Remove the CD from the CD-ROM drive, and then click the Finish button to restart the
server.

You can access VolP Monitoring Manager by selecting Start > Programs > Avaya > VoIP
Monitoring Manager. For more information about VolP Monitoring Manager, access the online
help after you start the application.

Initial configuration tasks must be performed the first time you use VolP Monitoring Manager.
See Avaya VoIP Monitoring Manager Release 3.0 Configuration, document number
555-233-510, for procedures you must perform the first time you run the software.

Installing VolP Monitoring Manager With a Database Already
Installed
Use this procedure if you want to use a local or remote database that is already installed. The

procedure is the same for Windows 2000, Windows 2003, or Windows XP Professional servers.
This procedure also includes installation of the WebLM server application.

1. See Installing the Software on page 31 and perform Steps 1 through 11. At Step 11, the
following dialog box appears:

The Install New Database or Use an Existing Database dialog box appears.
2. Select Use a database currently installed.

The Where is Your Database Located? dialog box appears.
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3. Based on whether the database is installed on this server or another server, go to one of the
following sections:

« If the database is installed on this machine, go to Database is Installed on This
Machine on page 41.

. If the database is installed on another machine, go to Database is Installed on Another
Machine on page 44.

Database is Installed on This Machine

Use this procedure if the database you are using is installed on this server.

1. See Installing VolP Monitoring Manager With a Database Already Installed on page 40 and
perform Steps 1 and 2. At Step 2, the following dialog box appears:

The Where is Your Database Located? dialog box appears.

2. Select Locally, on this machine, and click the Next button.

The Does the Database Need to be Initialized? dialog box appears.

3. Perform one of the following steps:

. Ifyes, select Yes, it needs to be initialized, and click the Next button.

The Configure Existing Database dialog box appears. Back up the existing database as
recommended. After the database is backed up, click the Next button.

If you are installing the WebLM License Server, the Enter WebLM Port Information
dialog box appears. Go to Step 4.

If you are not installing the WebLM License Server, the Enter WebLM Server
Information dialog box appears. Perform one of the following steps:

- If you have licenses to activate VolP Monitoring Manager beyond the 90-day trial
period, enter the IP address of the server on which the WebLM License Server
application is installed, and then click the Next button.

The Enter WebLM Port Information dialog box appears. Go to Step 4.

- If you do not have licenses for VolP Monitoring Manager, leave the IP address field
blank, and then click the Next button.

A message appears stating you have not entered a WebLM IP address and VolP
Monitoring Manager will run as an evaluation version for 90 days. Click the OK
button.

The Setup Summary dialog box appears. Go to Step 5.
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« If no, select No, it has existing VolP data, and click the Next button.

The Upgrade Existing Database on Local Machine dialog box appears. Back up the
existing database as recommended. After the database is backed up, click the Next
button.

. Ifyou are installing the WebLM License Server, the Enter WebLM Port Information
dialog box appears. Go to Step 4.

« If you are not installing the WebLM License Server, the Enter WebLM Server
Information dialog box appears. Perform one of the following steps:

- If you have licenses to activate VolP Monitoring Manager beyond the 90-day trial
period, enter the IP address of the server on which the WebLM License Server
application is installed, and then click the Next button.

The Enter WebLM Port Information dialog box appears. Go to Step 4.

- If you do not have licenses for VolP Monitoring Manager, leave the IP address field

blank, and then click the Next button.

A message appears stating you have not entered a WebLM IP address and VolP
Monitoring Manager will run as an evaluation version for 90 days. Click the OK
button.

The Setup Summary dialog box appears. Go to Step 5.

4. Enter the port number on which the WebLM License Server should run, and click the Next
button. The default is 3999.

The Setup Summary dialog box appears.

5. Review the setup information, and then click the Next button.
The Apache HTTP Server Welcome dialog box appears.

6. Click the Next button.
The Apache License Agreement dialog box appears.

7. Read the license agreement. If you accept the license agreement, click the | accept the
terms of the license agreement option button, and then click the Next button.

Note:
You cannot install Apache software unless you accept the license agreement.

The Apache information dialog box appears.
8. Read about the Apache HTTP server, and then click the Next button.

The Server Information dialog box appears.
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. Enter the Network Domain, Server Name, and Administrator’'s e-mail address. By default,

Apache HTTP server programs and short cuts will be installed for all users. Choose to
install only for current user if desired.

Note:

Network Domain, Server Name, and Administrator’s e-mail fields must be
completed. The Administrator’s e-mail address allows the system to notify the
administrator if problems occur during the Apache installation.

Click the Next button.
The Setup Type dialog box appears.
Confirm that Typical is selected, and then click the Next button.

The Choose Destination Location dialog box appears. By default, the files will be installed in
c:\Program Files\Apache Group.

Perform one of the following steps:
« To install the files in the default folder, click the Next button.

« To change the folder where the files will be installed, click the Change button, specify the
folder you want to use, and then click the Next button.

The Ready to Install Program dialog box appears.
Click the Install button.

The installation status bar for the Apache HTTP server appears. When the installation is
complete, the Installation Wizard Completed dialog box appears.

Click the Finish button.

The installation status bar for JRE appears. When the installation is complete, one of the
following dialog boxes appeatrs:

. If you are installing the WebLM License Server, the Java 2 License Agreement dialog
box appears. Go to Step 15.

« If you are not installing the WebLM License Server, the Installation Wizard Completed
dialog box appears. Go to Step 19.

Read the license agreement. If you accept the license agreement, click the | accept the
terms of the license agreement option button, and then click the Next button.

Note:
You cannot install Java 2 software unless you accept the license agreement.

The Custom Setup window appears. By default Development Tools is selected.
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16. Perform one of the following steps:
« To install the files in the default folder, click the Next button.

« To change the folder where the files will be installed, click the Change button, specify the
folder you want to use, and then click the Next button.

The Browser Registration dialog box appears.
17. Click the Install button.

The installation status bar for Java appears. When the installation is complete, the
InstallShield Wizard Completed dialog box appears.

18. Click the Finish button.
A message appears stating Java Development Kit will be used to install Apache Tomcat.
19. Click the OK button.

The installation status bar for VolP Monitoring Manager appears. When the installation is
complete, the InstallShield Wizard Completed dialog box appears.

20. Remove the CD from the CD-ROM drive, and then click the Finish button to restart the
server.

You can access VolP Monitoring Manager by selecting Start > Programs > Avaya > VoIP
Monitoring Manager. For more information about VolP Monitoring Manager, access the online
help after you start the application.

Initial configuration tasks must be performed the first time you use VolP Monitoring Managetr.
See Avaya VolP Monitoring Manager Release 3.0 Configuration, document number
555-233-510, for procedures you must perform the first time you run the software.

Database is Installed on Another Machine

Use this procedure if the database you are using is installed on another server.

1. See Installing VoIP Monitoring Manager With a Database Already Installed on page 40 and
perform Steps 1 and 2. At Step 2, the following dialog box appears:

The Where is Your Database Located? dialog box appears.
2. Select Remotely, on another machine, and click the Next button.
The Does the Database Need to be Initialized? dialog box appears.
3. Perform one of the following steps:
« Ifyes, select Yes, it needs to be initialized, and click the Next button.
The Enter the Database Server IP Address dialog box appears.
a. Enter the IP Address of your database location, and click the Next button.

The Configure Existing Database dialog box appears.
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b. Back up the existing database as recommended. After the database is backed up,
click the Next button.

. Ifyou are installing the WebLM License Server, the Enter WebLM Port Information
dialog box appears. Go to Step 4.

. If you are not installing the WebLM License Server, the Enter WebLM Server
Information dialog box appears. Perform one of the following steps:

If you have licenses to activate VolP Monitoring Manager beyond the 90-day trial
period, enter the IP address of the server on which the WebLM License Server
application is installed, and then click the Next button.

The Enter WebLM Port Information dialog box appears. Go to Step 4.

If you do not have licenses for VolP Monitoring Manager, leave the IP address field
blank, and then click the Next button.

A message appears stating you have not entered a WebLM IP address and VoIP
Monitoring Manager will run as an evaluation version for 90 days. Click the OK
button.

The Setup Summary dialog box appears. Go to Step 5.

« If no, select No, it has existing VoIP data, and click the Next button.

The Enter the Database Server IP Address dialog box appears.

a. Enter the IP Address of your database location, and click the Next button.

The Upgrade Existing Database on a Remote Machine dialog box appears.

b. Back up the existing database on remote machine as recommended. After the
database is backed up, click the Next button.

« If you are installing the WebLM License Server, the Enter WebLM Port Information
dialog box appears. Go to Step 4.

« If you are not installing the WebLM License Server, the Enter WebLM Server
Information dialog box appears. Perform one of the following steps:

If you have licenses to activate VolP Monitoring Manager beyond the 90-day trial
period, enter the IP address of the server on which the WebLM License Server
application is installed, and then click the Next button.

The Enter WebLM Port Information dialog box appears. Go to Step 4.

If you do not have licenses for VolP Monitoring Manager, leave the IP address field
blank, and then click the Next button.

A message appears stating you have not entered a WebLM IP address and VolP
Monitoring Manager will run as an evaluation version for 90 days. Click the OK
button.

The Setup Summary dialog box appears. Go to Step 5.
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10.

11.

12.

13.

. Enter the port number on which the WebLM License Server should run, and click the Next

button. The default is 3999.

The Setup Summary dialog box appears.

. Review the setup information, and then click the Next button.

The Apache HTTP Server Welcome dialog box appears.

. Click the Next button.

The Apache License Agreement dialog box appears.

. Read the license agreement. If you accept the license agreement, click the | accept the

terms of the license agreement option button, and then click the Next button.

Note:
You cannot install Apache software unless you accept the license agreement.

The Apache information dialog box appears.

. Read about the Apache HTTP server, and then click the Next button.

The Server Information dialog box appears.

. Enter the Network Domain, Server Name, and Administrator’s e-mail address. By default,

Apache HTTP server programs and short cuts will be installed for all users. Choose to
install only for current user if desired.

Note:

Network Domain, Server Name, and Administrator’s e-mail fields must be
completed. The Administrator’s e-mail address allows the system to notify the
administrator if problems occur during the Apache installation.

Click the Next button.
The Setup Type dialog box appears.
Confirm that Typical is selected, and then click the Next button.

The Choose Destination Location dialog box appears. By default, the files will be installed in
c:\Program Files\Apache Group.

Perform one of the following steps:
« To install the files in the default folder, click the Next button.

« To change the folder where the files will be installed, click the Change button, specify the
folder you want to use, and then click the Next button.

The Ready to Install Program dialog box appears.
Click the Install button.

The installation status bar for the Apache HTTP server appears. When the installation is
complete, the Installation Wizard Completed dialog box appears.
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20.

Installing the Software

Click the Finish button.

The installation status bar for JRE appears. When the installation is complete, one of the
following dialog boxes appeatrs:

. If you are installing the WebLM License Server, the Java 2 License Agreement dialog
box appears. Go to Step 15.

« If you are not installing the WebLM License Server, the Installation Wizard Completed
dialog box appears. Go to Step 19.

Read the license agreement. If you accept the license agreement, click the | accept the
terms of the license agreement option button, and then click the Next button.

Note:

You cannot install Java 2 software unless you accept the license agreement.
The Custom Setup window appears. By default Development Tools is selected.
Perform one of the following steps:
« To install the files in the default folder, click the Next button.

« To change the folder where the files will be installed, click the Change button, specify the
folder you want to use, and then click the Next button.

The Browser Registration dialog box appears.
Click the Install button.

The installation status bar for Java appears. When the installation is complete, the
InstallShield Wizard Completed dialog box appears.

Click the Finish button.
A message appears stating Java Development Kit will be used to install Apache Tomcat.
Click the OK button.

The installation status bar for VolP Monitoring Manager appears. When the installation is
complete, the InstallShield Wizard Completed dialog box appears.

Remove the CD from the CD-ROM drive, and then click the Finish button to restart the
server.

You can access VolP Monitoring Manager by selecting Start > Programs > Avaya > VoIP
Monitoring Manager. For more information about VolP Monitoring Manager, access the online
help after you start the application.

Initial configuration tasks must be performed the first time you use VolP Monitoring Managetr.
See Avaya VolP Monitoring Manager Release 3.0 Configuration, document number
555-233-510, for procedures you must perform the first time you run the software.
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Installing the Client Software

Use this procedure to install VolP Monitoring Manager Client on the Windows server or another
PC. The procedure to install or upgrade Avaya VolP Monitoring Manager Client is generally the
same. The VolP Monitoring Manager Client may be installed on the same machine as the VolP
Monitoring Manager Server, or it may be installed on another machine on the network.

1. Ask all users to log off the system.
2. Close all open windows and applications.

3. Insert the Avaya Integrated Management, VolP Monitoring Manager 3.0 CD into the
CD-ROM drive.

The Avaya Integrated Management, VolP Monitoring Manager window appears. It provides
the main menu.

Note:
Install Acrobat Reader if it is not already installed on the computer.

4. Click Install Monitoring Server.

The Welcome dialog box appears.
5. Click the Next button.

The Information dialog box appears.
6. Click the Next button.

The License dialog box appears.

7. Read the license type agreement. If you accept the license agreement, click the | accept
the terms of the license agreement option button, and then click the Next button.

Note:

You cannot install VolP Monitoring Manager unless you accept the license
agreement.

The Choose Destination Location dialog box appears. By default, the application will be
installed in c:\Program Files\Avaya.

8. Perform one of the following steps:
« To install the applications in the default folder, click the Next button.

« To change the folder where the applications will be installed, click the Change button,
specify the folder you want to use, and then click the Next button.

The Select Features dialog box appears. By default, all components are selected.
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9. Click the check boxes for VoIP Monitoring Manager Server and WebLM Server to
deselect them. Only VoIP Monitoring Manager Client should be selected. Click the Next
button.

The Enter Avaya Integrated Management Server IP Address dialog box appears.

10. Enter the IP Address of your Avaya Integrated Management Launch Page Server, and then
click the Next button.

The Enter VoIP Monitoring Manager Server IP Address dialog box appears.

11. Enter the IP address of your VolP Monitoring Manager Server, and click the Next button.
The Setup Summary dialog box appears.

12. Review the setup information and then click the Next button.

The installation status bar appears. When the installation is complete, the InstallShield
Wizard Complete dialog box appears.

13. Remove the CD from the CD-ROM drive, and then click the Finish button to restart the
computer.

Changing the RTCP Listen Port

The RTCP Listen Port must be the same as that administered on the Avaya Communication
Manager Server. Use this procedure to change the RTCP Listen Port on the VolP Monitoring
Manager server to match the port number administered on the Communication Manager. When
you install the VolP Monitoring Manager server, you are prompted for the RTCP Monitoring
Listen Port. The default is 5005. See Configuring the Avaya Communication Manager
Administration Forms on page 27 for more information.

To change the RTCP Listen Port, follow these steps:
1. Start the VolP Monitoring Manager server application.
2. On the Edit menu, click Options.
The Server Options dialog box displays.
3. Click the RTCP tab and enter the new RTCPListen Port.
4. Click OK to save the changes and close the dialog box or Cancel to close without saving.

The VolP Monitoring Manager Server will reset the properties and attempt to re-connect to
the Windows SNMP Agent based on the new properties.
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Note:

Changing the RTCP port displays a warning indicating it must match the port
configured on the Avaya Communication Manager Server. See http://
www.iana.org/assignments/port-numbers and your Avaya Communication
Manager documentation. It is unusual to change the listen port from the default of
5005. The default should be suitable in most situations.

Note:

An SNMP Community ID with write privileges must be configured before changes
can be applied. (See Checking for Valid Community ID on page 27.)

Installing VoIP Monitoring Manager Licenses

After the WebLM License Server is installed, you can install the VolP Monitoring Manager
licenses so that you can use VolP Monitoring Manager beyond the 90-day trial period.

Note:
To purchase the licenses, contact your Avaya representative.
To install VolP Monitoring Manager licenses, follow these steps:
1. Select Start>Programs>Avaya>Avaya Integrated Management WebLM Server Login.
The Web License Manager login page appears.
2. In the User Name field, enter the default user name admin.
3. In the Password field, enter the default password, weblmadmin.
4. Click the Login button.

Note:

See the administrator for the WebLM License Server for the login and password
to use after you log in for the first time using the default user name and password.

5. Click Install Licenses in the left-hand panel of the window.
6. Click the Browse button and select the license files you want to install.

7. Click the Install button to install the selected license files.

Note:

An error message appears if the license file name is invalid, belongs to another
license server, or is already installed on the current license server.

8. Click Licensed Products > IMMS in the left-hand panel to display the license details.

50 Avaya Integrated Management Standard Management Installation and Upgrade


http://www.iana.org/assignments/port-numbers
http://www.iana.org/assignments/port-numbers

Index

Symbols
> meaning ofintext. . . . . . ... ... .. ... 8
A
Avaya
SUPPOrtresources . . . . . . . . . . . ... . 8
supportwebsite . . . ... ... ..o 12
Avaya Site Administration . . . . . . .. ... .. 15
B
bold text, meaningof. . . . . . . .. .. ... ... 8
C
contact information for Avaya. . . . . . . .. .. .. 11
courier font, meaningof . . . . . .. ... ... .. 8
=
feedback about thisbook. . . . . . .. ... ... 12
H
HP OpenView
Network Node Manager. . . . . . . ... ... 24
I
Installation
with database already installed . . . . . . . .. 40
with database installed on another machine 44
with database installed on this machine . . . . . 41
with database is installed on this machine . . . . 41
with MSDE on Windows 2000 . . . . . . . . .. 33
with MSDE on Windows 2003 or Windows XP
Professional . . . . ... ... .. ... .. 37
installation
Avaya Site AdministratonCD . . . . . . . . .. 17
Windows server . . . . . . .. ... ... 31, 48
IP-Network-RegionForm. . . . . . . .. ... .. 28
P
prerequisites, forinstalling . . . . . . . ... .. .. 7

R

Index

requirements
Windowsclient . . . . . . . . ... ... ... 16
Windowsserver. . . . . . . ... ... 23

resources

Avaya Communications, Solutions, and Integration
(CSI) Group of Software Services. . . . . . . .. 8

Avaya Network Management Software Systems
Support Group (NMSSS) . . . . . . . . . . ...

9
Avaya Technical Service Organization (TSO) . . . .9
Avaya Technology and Consulting (ATAC) 8
Customized Management Solutions for Avaya

Integrated Management . . . . . . . . . . .. 10
S
Simple Network Management Protocol Agent. . . 19, 23
SNMP agent
seeifitisrunning . . . . . . . .. ... .. L. 26
Standard Management
defined . . . . . . .. . ... ... 13
pre-installationtasks. . . . . . . . ... .. .. 15
Standard Management CDs
defined . . . . . . .. .. ... ... ... 13
System -Parameters IP-Options Form . . . . . . . . 29
T
typographical conventions. . . . . . . . .. .. ... 8
\Y,
VolP Monitoring Manager
advancedsearch . . . . . .. ... ... ... 19
CD. . . . e 30
components. . . . .. .. ..o 19
defined . . . . . . .. . ... ... 19
exportingreports . . . . . . . .. . ... ... 19
generatingtraps. . . . . . . . .. ... ... 19
GUL. . . . oo 20
pre-installation tasks. . . . . . .. ... .. .. 21
searchingendpoints. . . . . . . . .. .. ... 19
W
WebClient. . . . .. .. ... ... ....... 20
Windows SNMP Agent . . . . . . . . . ... ... 19

Issuel June 2005 51



Index

52 Avaya Integrated Management Standard Management Installation and Upgrade



	Avaya Integrated Management Release 3.0 Standard Management Installation and Upgrade
	Contents
	Chapter 1: Introduction
	Purpose
	Prerequisites
	Intended Audience
	Conventions Used in This Book
	Support Resources
	Avaya Technology and Consulting (ATAC)
	Communications, Solutions, and Integration (CSI) Group of Software Services
	Avaya Technical Service Organization (TSO)
	Avaya Network Management Software Systems Support Group (NMSSS)
	Customized Management Solutions for Avaya Integrated Management
	Avaya Contact Information

	Product Documentation
	How to Access Books on the Web
	Tell Us What You Think!

	Chapter 2: Overview
	Standard Management
	Standard Management CDs

	Chapter 3: Avaya Site Administration Installation
	Overview of Avaya Site Administration
	Avaya Site Administration CD
	Pre-Installation Tasks
	PC Requirements
	Installing the Software
	Uninstalling the Software

	Chapter 4: VoIP Monitoring Manager Installation
	Overview of Avaya VoIP Monitoring Manager
	Avaya VoIP Monitoring Manager Components
	Avaya VoIP Monitoring Manager Server
	Avaya VoIP Monitoring Manager RTCP Monitor
	Avaya VoIP Monitoring Manager Client
	Avaya VoIP Monitoring Manager Web Client
	WebLM License Server

	Pre-Installation Tasks
	VoIP Monitoring Manager System Requirements
	Ensuring Windows SNMP Service is Installed
	Checking for Valid Community ID
	Configuring the Avaya Communication Manager Administration Forms
	Configuring the IP Network Region Form
	Configuring the System Parameters IP-Options Form

	VoIP Monitoring Manager CD
	Avaya VoIP Monitoring Manager License Key
	Microsoft SQL 2000 Database
	Installing the Software
	Installing VoIP Monitoring Manager and MSDE on a Windows 2000 Server
	Installing VoIP Monitoring Manager and MSDE on a Windows 2003 or Windows XP Professional Server
	Installing VoIP Monitoring Manager With a Database Already Installed
	Database is Installed on This Machine
	Database is Installed on Another Machine


	Installing the Client Software
	Changing the RTCP Listen Port
	Installing VoIP Monitoring Manager Licenses

	Index
	Symbols
	A
	B
	C
	F
	H
	I
	P
	R
	S
	T
	V
	W


